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ABSTRAK  

Analisis spasial menggunakan Sistem Informasi Geografis (SIG) sangat 

mendukung untuk pengambilan keputusan dalam penanggulangan penyakit 

berbasis lingkungan. SIG dapat menjadi alat atau media untuk melakukan 

mobililasi juga survey ke lokasi kejadian kasus diare serta berguna untuk 

menginformasikan wilayah persebaran tingkat kasus diare dengan sarana air 

bersih dan jamban. Tujuan penelitian untuk menganalisis spasial sebaran kejadian 

diare pada balita dengan melihat bagaimana sarana air bersih dan juga 

pengelolaan pembuangan tinja (jamban) pada rumah Balita penderita Diare di 

wilayah kerja Puskesmas Lubuk Buaya Kota Padang.  

Jenis penelitian yang digunakan adalah penelitian deskriptif dengan studi 

observasional dari data sekunder Puskesmas Lubuk Buaya. Pengambilan sampel 

menggunakan teknik total sampling terhadap 22 balita. Data diperoleh dengan 

melakukan wawancara serta menggunakan lembar observasi. Pengolahan data 

dilakukan dengan komputerisasi dan hasil penelitian disajikan dalam bentuk tabel 

distribusi frekuensi dan layout.  

Hasil penelitian analisis spasial menunjukkan bahwa 22 balita dengan 

berbagai Risiko yaitu Tinggi, Sedang, dan Rendah, dengan klasifikasi Tinggi 

berwarna kuning, klasifikasi Sedang berwarna oranye, dan Klasifikasi Rendah 

berwarna hijau, yang tersebar di wilayah kerja Puskesmas Lubuk Buaya, yaitu 

Kelurahan Lubuk Buaya, Kelurahan Pasie Nan Tigo, Kelurahan Batang Kabung 

Gantiang, dan Kelurahan Parupuk Tabing 

Kesimpulan diharapkan kepada Puskesmas dalam pendataan pasien untuk 

melengkapi data agar untuk penelusuran dilapangan tidak terkendala, sedangkan 

bagi masyarakat di wilayah kerja puskesmas lubuk buaya yang terdampak diare 

dengan resiko pencemaran sedang hingga tinggi agar dapat memperhatikan sarana 

prasarana baik dari segi kualitas air bersih serta jamban disarankan kepada 

masyarakat juga untuk membangun bak septik secara komunal agar tidak terjadi 

risiko pencemaran.  

Kata Kunci : diare, sarana air bersih, jamban, SIG 

Daftar Pustaka : 28 (2009 – 2022)  
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ABSTRACT 

Spatial analysis using Geographic Information Systems (GIS) is very 

supportive for decision making in environment-based disease management. GIS 

can be a tool or media for mobilizing as well as surveys to the locations of cases 

of diarrhea and is useful for informing the area of distribution of cases of 

diarrhea with clean water and latrines. The aim of the study was to analyze the 

spatial distribution of the incidence of diarrhea in toddlers by looking at how 

clean water facilities and also the management of feces disposal (latrines) are in 

the homes of toddlers with diarrhea in the working area of the Lubuk Buaya 

Health Center, Padang City. 

The type of research used is descriptive research with an observational 

study of secondary data from the Lubuk Buaya Health Center. Sampling used a 

total sampling technique of 22 toddlers. Data were obtained by conducting 

interviews and using observation sheets. Data processing is done by 

computerization and research results are presented in the form of frequency 

distribution tables and layouts. 

The results of the spatial analysis study showed that 22 toddlers with 

various risks, namely High, Medium, and Low, with the High classification in 

yellow, the Medium classification in orange, and the Low Classification in green, 

which are scattered in the working area of the Lubuk Buaya Health Center, 

namely Lubuk Buaya Village, Pasie Nan Tigo Sub-District, Batang Kabung 

Lilinang Sub-District, and Parupuk Tabing Sub-District 

The conclusion is that it is hoped that the Puskesmas in patient data 

collection will complete the data so that field investigations are not constrained, 

while for people in the working area of the Lubuk Crocodile Health Center who 

are affected by diarrhea with moderate to high risk of pollution so that they can 

pay attention to infrastructure both in terms of clean water quality and latrines it 

is recommended to community also to build septic tanks communally so there is 

no risk of contamination. 

Keywords: diarrhea, clean water facilities, latrines, GIS 
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BAB I 

PENDAHULUAN 

A. Latar Belakang 

Berdasarkan Undang–Undang Nomor 36 Tahun 2009 tentang 

Kesehatan, kesehatan adalah keadaan sehat, baik secara fisik, mental, 

spiritual maupun social yang memungkinkan setiap orang untuk hidup 

produktif secara sosial dan ekonomis.
1
 

Berdasarkan Peraturan Menteri Kesehatan Republik Indonesia 

Nomor 21 Tahun 2020 tentang rencana strategis Kementerian Kesehatan 

tahun 2020-2024 telah mensyaratkan adanya upaya perubahan tata kelola 

pembangunan kesehatan yang meliputi integrasi sistem informasi, 

penelitian, dan pengembangan kesehatan. Permasalahan layanan kesehatan 

berupa, layanan kesehatan primer dan sekunder, layanan farmalkes, 

layanan ketahanan kesehatan, layanan sumber daya manusia kesehatan, 

layanan pembiayaan kesehatan, layanan manajemen internal, dan layanan 

bioteknologi.
2
 

Hasil Riset Kesehatan Dasar tahun 2018 memperlihatkan 

prevalensi diare untuk semua kelompok umur sebesar 8 %, balita sebesar 

12,3 %, dan pada bayi sebesar 10,6 %. Sementara pada Sample 

Registration System tahun 2018, diare tetap menjadi salah satu penyebab 

utama kematian pada neonatus sebesar 7% dan pada bayi usia 28 hari 

sebesar 6 %.
3
 

Kejadian diare pada balita di Provinsi Sumatera Barat terhitung 

dengan prevalensi 8,25 % dengan karakteristik tertinggi pada umur 1-4 



2 

 

2 

 

tahun dan terendah pada umur 35-44 6,76 %, dengan jenis kelamin 

tertinggi pada perempuan 9,03 % dan laki - laki 7,47 %. 
4
 

Berdasarkan data yang diperoleh dari Profil Kesehatan Kota 

Padang tahun 2021, jumlah penderita diare adalah 26.581 kasus dari 

984.490 penduduk Kota Padang dan meninggal sebanyak 8 orang.
5
 Pada 

laporan tahunan 2022 Puskesmas Lubuk Buaya tercatat 53 kasus diare 

pada Balita yang tersebar di 4 wilayah kerja Puskesmas Lubuk Buaya. 

Diantaranya terdapat 2 Balita yang melakukan beberapa kali kunjungan. 

Balita dengan alamat yang lengkap hanya terdapat 22 Balita.
6
  

Penyakit diare biasa dikaitkan dengan kurangnya sarana sanitasi 

dasar seperti air bersih dan jamban sehat, penurunan kualitas lingkungan 

udara, air dan tanah serta kesadaran akan perilaku hidup bersih dan sehat 

yang belum membudaya di masyarakat. Selain itu, penyakit diare juga 

merupakan penyakit yang berbasis lingkungan. Tingginya kejadian 

penyakit berbasis lingkungan disebabkan oleh masih buruknya kondisi 

sanitasi dasar. 
7
 

Analisis spasial menggunakan Sistem Informasi Geografis (SIG) 

sangat mendukung untuk pengambilan keputusan dalam penanggulangan 

penyakit berbasis lingkungan. Prinsip dasar dari konsep ini adalah 

pemanfaatan SIG untuk mengkonversi data populasi, data penyakit, data 

lingkungan, fasilitas kesehatan, dan lain sebagainya, menjadi bentuk visual 

seperti peta dan grafik guna memudahkan interpretasi data penyakit serta 

mendukung pengambilan keputusan terkait program penanggulangan 

penyakit berbasis lingkungan. Fungsi analisis spasial dari SIG termasuk 
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antara lain klasifikasi, penilaian, tumpang susun, dan fungsi-fungsi 

lingkungan. Integrasi SIG dan penginderaan jauh mempermudah analisis 

spasial karena kenampakan yang mendekati dunia nyata. Produk luaran 

yang dihasilkan dari analisis spasial adalah: identifikasi wilayah berisiko 

tinggi, persebaran kasus, tren waktu, populasi berisiko, memantau kegiatan 

surveilans dan penanggulangan penyakit, penilaian aksesibilitas terhadap 

fasilitas kesehatan serta memperkirakan terjadinya kasus di masa datang.
8
 

SIG dapat menjadi media untuk menginformasikan lokasi sebaran 

kejadian kasus diare di wilayah kerja Puskesmas. Menjadi alat atau media 

untuk melakukan mobililasi juga survey ke lokasi kejadian kasus diare.  

Puskesmas Lubuk Buaya berada pada Kecamatan Koto Tangah 

Kota Padang. Puskesmas Lubuk Buaya memiliki wilayah kerja yang 

terbagi atas beberapa Kelurahan yaitu Batang Kabung, Parupuk Tabing, 

Lubuk Buaya dan Pasie Nan Tigo. 

Peta berguna untuk menginformasikan wilayah persebaran tingkat 

kasus diare dengan sarana air bersih dan jamban.  Analisis Spasial Sebaran 

Kejadian Kasus Diare dengan sarana air bersih dan jamban dapat 

menggunakan Sistem Informasi Geografis (SIG) dengan bantuan Software 

ArcGis 10.6. 

B. Rumusan Masalah 

Berdasarkan penjelasan latar belakang di atas, rumusan masalah 

pada penelitian ini adalah bagaimana Analisis Spasial Kejadian diare pada 

balita Dengan Sarana air bersih dan jamban di Wilayah Kerja Puskesmas 

Lubuk Buaya Kota Padang. 
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C. Tujuan Penelitian 

1. Tujuan Umum 

Penelitian ini bertujuan untuk menganalisis spasial sebaran 

kejadian diare pada balita dengan melihat bagaimana sarana air bersih 

dan juga pengelolaan pembuangan tinja (jamban) pada rumah Balita 

penderita Diare di wilayah kerja Puskesmas Lubuk Buaya Kota 

Padang. 

2. Tujuan Khusus 

a) Diketahuinya sebaran kejadian diare pada balita di wilayah kerja 

Puskesmas Lubuk Buaya Kota Padang Tahun 2023. 

b) Diketahuinya distribusi spasial sarana air bersih pada rumah 

penderita Diare di wilayah kerja Puskesmas Lubuk Buaya Kota 

Padang Tahun 2023. 

c) Diketahuinya distribusi spasial sarana jamban pada rumah 

penderita Diare di wilayah kerja Puskesmas Lubuk Buaya Kota 

Padang tahun 2023. 

D. Manfaat Penelitian 

1. Perkembangan ilmu Pengetahuan 

Sebagai referensi tentang analisis spasial sebaran kejadian diare 

pada balita dengan cakupan sarana air bersih dan cakupan jamban 

keluarga. 
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2. Bagi Institusi Pendidikan 

Hasil penelitian ini diharapkan dapat menjadi bahan dalam 

pertimbangan menyusun pembelajaran. 

3. Bagi Puskesmas 

Hasil penelitian ini diharapkan dapat menjadi sarana 

informasi/data tambahan bagi Puskesmas Lubuk Buaya tentang 

sebaran penyakit diare. 

E. Ruang Lingkup Penelitian  

Ruang lingkup penelitian ini adalah mengetahui analisis spasial 

sebaran kejadian diare pada balita dengan sarana air bersih dan jamban di 

wilayah kerja Puskesmas Lubuk Buaya Kota Padang. 

. 
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BAB II 

TINJAUAN PUSTAKA 

A. Diare 

1. Pengertian Diare 

Diare adalah Buang Air Besar (BAB) encer atau bahkan dapat 

berupa air saja (mencret) biasanya lebih dari 3 kali dalam sehari. Diare 

atau penyakit diare (Diarrhead Disease) berasal dari bahasa yunani 

yaitu Diarroi yang artinya mengalir terus, adalah keadaan abnormal 

dari pengeluaran tinja yang frekuen.
9
 

Diare adalah buang air besar dengan frekuensi yang tidak 

normal (meningkat) dan konsistensi tinja yang lebih lembek atau cair, 

istilah gastroenteritis hendaknya dikesampingkan saja, karena 

memberikan kesan terdapatnya suatu radang sehingga selama ini 

penyelidikan tentang diare cenderung lebih ditekankan pada 

penyebabnya. 
10

 

2. Etiologi 

Secara klinis penyebab diare dapat dikelompokkan dalam 6 

golongan besar yaitu infeksi (disebabkan oleh bakteri, virus atau 

infeksi parasit), malabsorpsi, alergi, keracunan, imunodefisiensi dan 

sebab-sebab lainnya. Infeksi dan keracunan merupakan penyebab yang 

banyak ditemukan secara klinis.
11

 

Penyebab diare dapat dikelompokkan menjadi : 

1. Virus : Rotavirus (40-60%), Adenovirus. 
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2. Bakteri : Escherichia coli (20-30%), Shigella sp. (1-2%), 

Vibrio cholera, dll. 

3. Parasit : Entamoeba histolytica (< 1%), Gardia lamblia, 

Cryptosporidium (4-11%). 

4. Keracunan Makanan. 

5. Malabsorpsi : Karbohidrat, lemak dan protein. 

6. Alergi : Makanan, susu sapi. 

7. Imunodefisiensi : Acquired Immune Deficiency Syndrome 

 ( AIDS ) 

Penyebab diare akut terbesar adalah infeksi virus dari golongan 

rotavirus. 

3. Faktor Penyebab Penyakit Diare 

1. Faktor Lingkungan 

Sanitasi Lingkungan perumahan berkaitan dengan penularan 

penyakit, khususnya diare. Secara umum sanitasi lingkungan yang 

berhubungan dengan penularan penyakit terdapat 4 aspek yaitu : 

a) Sarana Air bersih 

Sarana air bersih dapat menjadi salah satu faktor tingginya 

kejadian diare. Hal ini terjadi dikarenakan sarana air bersih tersedia 

telah tercemar oleh mikroorganisme. Sarana air bersih dapat 

tercemar disebabkan oleh kebiasan masyarakat yang tidak menjaga 

kebersihan disekitar sarana air bersih, konstruksi sarana air besih 

yang tidak memenuhi persyaratan baku mutu, yaitu berjarak <8-10 
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meter dari sumber pencemar, seperti sarana pembuangan air limbah 

dan kandang ternak. 

Bagi keluarga balita yang mempunyai sarana air bersih 

yang kurang baik berisiko 2,9 kali terhadap diare dibandingkan 

dengan balita dengan keluarga yang mempunyai sarana air bersih 

yang baik.
12

 Dapat disimpulkan bahwa sarana air bersih memiliki 

hubungan dengan kejadian diare pada balita. 

b) Jamban (Pembuangan kotoran manusia) 

Jamban adalah suatu bangunan yang digunakan untuk 

membuang dan mengumpulkan kotoran manusia dalam suatu 

tempat, sehingga kotoran tersebut tidak menjadi penyebab penyakit 

dan mengotori lingkugan pemukiman 
13

. Sanitasi jamban menjadi 

salah satu factor hygiene dan sanitasi pemukiman. Faktor jamban 

yang tidak memenuhi syarat dapat menjadi sumber penyebaran 

penyakit terutama diare yang disebabkan oleh kotoran manusia 

yang mengandung banyak mikroorganisme pathogen seperti 

E.Coli. 

Syarat pembuangan kotoran manusia (jamban) yang 

memenuhi aturan kesehatan adalah tidak mengotori permukaan 

tanah di sekitarnya, tidak mengotori air permukaan disekitarnya, 

tidakm mengotori air dalam tanah di sekitarnya dan kotoran tidak 

boleh terbuka. 
12

 

c) Sarana pembuangan sampah 
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Sampah eratkaitannya dengan kesehatan masyarakat, 

karena dari sampah tersebut akan hidup berbagai mikroorganisme 

penyebab penyakit (bakteri pathogen), dan juga binatang serangga 

sebagai vector penyakit. 
13

 

Sarana pembuangan sampah harus memenuhi syarat-syarat 

kesehatan agar tidak menjadi media penularan penyakit diare. 

Syarat-syarat sarana pembuangan sampah yang memenuhi 

persyaratan yaitu melakukan pengelolaan sampah dengan 

pembakaran yang dapat menyebabkan pencemaran pada tanah 

hingga air tanah, tidak meletakkan sampah campur pada galian 

tanah, tidak meletakkan sampah organic pada galian tanah yang 

berjarak <10 meter dari sumber air bersih dan disediakannya 

tempat penampungan yang tertutup dan kedap air. 

d) Sarana pembuangan air limbah 

Air limbah baik yang berasal dari rumah tangga, industri, 

perkantoran, perhotelan dan lainnya sebelum dibuang ke 

lingkungan harus melalui proses pengolahan. Sarana air 

pembuangan limbah yang tidak memenuhi syarat dapat menjadi 

media penularan penyakit, merusak estetika lingkungan, 

mengganggu kenyamana dan menjadi tempat perindukan serangga 

penyebab masalah kesehatan. 

e) Makanan dan Minuman 

Makan dan Minuman yang terkontaminasi lebih banyak 

terjadi pada anak dan balita, seperti makanan yang tercemar, 
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basi, mengandung racun mengandung banyak lemak, mentah 

(sayuran) dan makanan yang kurang matang. 

Syarat sarana pembuangan air limbah yang memenuhi 

syarat yaitu tidak terbuka, tidak langsung kontak dengan tanah, dan 

berjarak <10 meter dari sarana air bersih. 

2. Faktor Pendidikan 

Secara umum pendidikan merupakan upaya yang direncanakan 

untuk mempengaruhi orang lain sehingga mereka melakukan yang 

diharapka oleh pelaku pendidikan. 

3. Faktor Sosial, Budaya dan Ekonomi 

Kebiasaan dan tradisi yang dilakukan orang-orang tanpa 

melalui penalaran apakah yang dilakukan itu baik atau buruk. Status 

ekonomi seseorang juga akan dapat menentukan tersedianya suatu 

fasilitas yang diperlukan untuk kegiatan tertentu sehingga status sosial 

ekonomi ini akan mempengaruhi pengetahuan seseorang juga derajat 

keseshatan akan meninggkat. 
14

 

4. Faktor Pengetahuan 

Pengetahuan merupakan hasil dari tahu, dan hal ini terjadi 

setelah seseorang melakukan penginderaan terhadap suatu objek 

tertentu. Penginderaan tersebut terjadi melalui pancaindra manusia 

yakni indra penglihatan, pendengran, penciuman, rasa dan raba. 

Namun, sebagian besar pengetahuan seseorang diperoleh melalui mata 

dan telinga.
15
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B. Sarana Air Bersih 

1. Pengertian Air Bersih 

Air untuk keperluan higiene sanitasi adalah air dengan kualitas 

tertentu dan digunakan untuk keperluan sehari-hari yang kualitasnya 

berbeda dengan air untuk keperluan minum.
16

 

Air bersih adalah air yang digunakan untuk keperluan sehari-

hari yang kualitasnya memenuhi syarat kesehatan dan dapat diminum 

apabila telah dimasak. Air bersih juga dipergunakan untuk kebutuhan 

rumah tangga seperti untuk memasak, mencuci pakaian dan perlatan 

memasak atau peralatan lainnya. Selain itu juga, air digunakan untuk 

keperluan industri, pertanian, pemadam kebakaran, tempat rekreasi, 

transportasi, dan lain-lain.
17

 

2. Sumber Air Bersih 

Sumber air bersih dibagi menjadi empat kelompok yaitu air 

permukaan, air tanah, air hujan dan mata air. 

a. Air permukaan  

Air permukaan adalah air yang dapat dimanfaatkan 

sebagai sumber atau bahan baku air minum antara lain : 

1) Air waduk (berasal dari air hujan) 

2) Air sungai (berasal dari air hujan dan mata air) 

3) Air danau (berasal dari air hujan, mata air dan 

sungai) 

Air permukaan merupakan air hujan yang 

mengalir diatas permukaan bumi. Selama 
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pengalirannya, air permukaan mendapat pengotoran 

dari lumpur, batang kayu dan daun-daun. 

b. Air tanah 

Air tanah adalah air yang keberadaanya di bawah 

permukaan air tanah, sumber air yang utama untuk sumber 

air minum, kebanyakan air tanah ini menjadi masalah 

utama, air tanah adalah air yang keluar dengan sendirinya 

kepermukaan. Mata air yang bersumber dari tanah dalam 

tidak dipengaruhi dan kualitas dan kuantitasnya sama 

dengan keadaan air dalam tanah. Air tanah yang berada di 

dalam tanah harus digali atau di bor untuk mendapatkannya 

agar air keluar ke permukaan tanah, pada umumnya air 

tanah yang berasal dari air hujan yang melalui proses 

infiltrasi secara langsung atau tidak langsung dari air sungai 

danau rawa dan genangan air lainnya. 

c. Air hujan 

Teradinya air hujan dikarenakan proses penguapan, 

terutama air permukaan laut yang naik ke atmosfer dan 

mengalami pendinginan kemudian jatuh kepermukaan 

bumi, selama proses penguapan tersebut berlangsung. 

Misalnya saat butiran hujan jatuh ke permukaan bumi 

sebagian butiran hujan lainnya akan menguap sebelum 

sampai di permukaan bumi. Sebagian lainnya akan tertahan 

pada tumbuhan dan matahari akan diuapkan kembali ke 
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atmosfer. Air hujan yang sampai di bumi akan mengisi 

cekungan kubangan dipermukaan bumi dan sebagian akan 

mengalir di permukaan bumi. 

d. Mata air 

Mata air adalah air tanah yang dapat mencapai 

permukaan tanah melalui celah bebatuan karena adanya 

perbedaan tekanan. Mata air 13 bersumber dari deposit air 

tanah yang bebas dari bakteri patogen bila cara 

pengambilannya baik, maka dapat langsung diminum tanpa 

pengolahan khusus, dan banyak mengandung mineral , 

pada pengelolaan mata air yang dikelola untuk keperluan 

kelompok rumah tangga yang di beri bangunan pelindung.
18

 

C. Sarana Jamban 

1. Pengertian Jamban 

Menurut Peraturan Menteri Kesehetan Nomor 39 Tahun 2016, 

Definisi Jamban adalah suatu bangunan yang digunakan untuk tempat 

membuang dan mengumpulkan kotoran manusia yang lazim disebut kakus 

atau WC, dengan atau tanpa kloset dan dilengkapi sarana penampungan 

kotoran/tinja sehingga tidak menjadi penyebab atau penyebar penyakit dan 

mengotori lingkungan pemukiman.
19

 

Menurut Soeparman dalam Syadza Firdausiah, jamban adalah 

jamban adalah suatu ruangan yang mempunyai fasilitas pembuangan 

kotoran manusia yang terdiri atas tempat jongkok atau tempat duduk 

dengan leher angsa atau tanpa leher angsa (cemplung) yang dilengkapi 
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dengan unit penampungan kotoran dan air untuk membersihkan. 

Pembuangan tinja merupakan salah satu upaya kesehatan lingkungan yang 

harus memenuhi sanitasi dasar bagi setiap keluarga. Pembuangan kotoran 

yang baik harus dibuang kedalam tempat penampungan kotoran yang 

disebut jamban.
20

 

2. Jenis – jenis  sarana jamban 

Ada beberapa macam samara jamban yang sesuai dengan 

konstruksi jamban :  

a. Jamban Cemplung  

Bentuk jamban ini adalah paling sederhana yang dapat 

dianjurkan pada masyarakat. Jamban cemplung ini hanya terdiri 

dari sebuah lubang galian diatasnya diberi lantai dan tempat 

jongkok, sedang dari tempat jongkok kelubang galian tidak 

terdapat alat apapun sebagai penyalur maupun penghalang. Lantai 

jamban ini pun dapat dibuat dari bambu atau kayu, tapi dapat juga 

dari pasangan batu bata atau beton. Agar tidak menjadi sarang dan 

makanan serangga penyebar penyakit, maka lubang tempat jongkok 

harus ditutup bila tidak dipakai. Jamban semacam ini masih 

menimbulkan gangguan karena bau busuknya.   

b. Jamban Plengsengan  

Tempat jongkok dari jamban ini di hubungkan oleh suatu 

saluran miring ke tempat pembuangan kotoran. Jamban semacam 

ini sedikit lebih baik dan menguntungkan dari pada jamban 

cemplung, karena baunya agak berkurang, dan keamanan bagi 
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pemakai lebih terjamin. Seperti halnya pada jamban cemplung, 

maka lubang dari tempat jongkok harus dibuatkan tutup.  

c. Jamban Bor  

Dinamakan demikian karena tempat penampungan kotorannya 

dibuat dengan mempergunakan bor. Lubang pada jamban ini harus 

jauh lebih dalam dibandingkan dengan lubang yang digali seperti 

pada jamban  cemplung atau plengsengan, karena diameter jamban 

bor ini jauh lebih kecil. Pengeboran pada umumya dilakukan 

sampai mengena air tanah. Perlengkapan lainnya dan cara 

mempergunakan, dapat pula diatur seperti pada jamban cemplung 

dan jamban plengsengan.  

d. Jamban  Angsatrine (Water Seal Laterine)  

Jamban  ini, dibawah tempat jongkoknya ditempatkan atau 

dipasangkan suatu alat yang berbentuk seperti leher angsa yang 

disebut bowl. Bowl ini berfungsi mencegah timbulnya bau. 

Kotoran yang berada ditempat penampungan tidak tercium baunya, 

karena terhalang oleh air yang selalu terdapat dalam bagian yang 

melengkung, dengan demikian juga dapat mencegah hubungan lalat 

dengan kotoran. Karena dapat mencegah gangguan lalat dan bau, 

maka memberikan keuntungan untuk dibuat didalam rumah. Agar 

terjaga kebersihannya, jamban semacam ini harus cukup tersedia 

air.  
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e. Jamban septic tank  

Jamban ini sama dengan jamban sistem resapan. Perbedaanya 

terletak pada jumlah septik tank dan cara pembuangannya. Jumlah 

septik tank ganda mempunyai dua atau lebih lubang penampung 

kotoran. Cara pemakaian dilakukan bergilir setelah salah satu bak 

penampung terisi penuh. Bak penampung yang telah penuh ditutup 

dan didiamkan beberapa lama supaya kotoran dapat dijadikan 

kompos atau pupuk. Saluran pembuangan dapat dipindahkan 

dengan menutup/membuka lubang saluran yang dikehendaki pada 

bak pengontrol. Kotoran yang telah berubah menjadi kompos dapat  

diambil dan dimanfaatkan sebagai pupuk. Bak penampung yang 

telah dikosongkan dapat dimanfaatkan kembali.
21

 

D. Sistem Informasi Geografis (SIG) 

1. Pengertian Sistem Infomasi Geografis 

SIG merupakan sistem informasi berbasis computer yang 

digunakan secara digital untuk menggambarkan dan menganalisa ciri-

ciri geografi yang digambarkan pada permukaan bumi dan kejadian-

kejadiannya (atribut-atribut non spasial untuk dihubungkan dengan 

studi mengenai geografi).  

SIG dirancang untuk mengumpulkan, menyimpan dan 

menganalisa obyek-obyek dan fenomena dimana lokasi geogragi 

merupakan karakteristik yang penting atau kritis untuk dianalisis. 

Dengan demikian Sistem Informasi Geogragis (SIG) merupakan 

sistem computer yang memiliki empat kemampuan berikut dalam 
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menangani data yang bereferensi geografi : manajemen data 

(penyimpanan dan pemanggilan data), analisis dan manipulasi data, 

dan keluaran. 
22

 

Sistem Informasi Geografis dibagi menjadi dua kelompok yaitu 

sistem manual (analog), dan sistem otomatis (yang berbasis digital 

komputer). Perbedaan yang paling mendasar terletak pada cara 

pengelolaannya. Sistem Informasi manual biasanya menggabungkan 

beberapa data seperti peta, lembar transparansi untuk tumpang susun 

(overlay), foto udara, laporan statistik dan laporan survey lapangan. 

Kesemua data tersebut dikompilasi dan dianalisis secara manual 

dengan alat tanpa komputer. Sedangkan Sistem Informasi Geografis 

otomatis telah menggunakan komputer sebagai sistem pengolah data 

melalui proses digitasi. Sumber data digital dapat berupa citra satelit 

atau foto udara digital serta foto udara yang terdigitasi. Data lain dapat 

berupa peta dasar terdigitasi. 
23

 

2. Analisis Sistem Infomasi Geografis (SIG) 

Alasan SIG dibutuhkan adalah karena untuk data spasial 

penanganannya sangat sulit terutama karena peta dan data statistik 

cepat kadaluarsa sehingga tidak ada pelayanan penyediaan data dan 

informasi yang diberikan enjadi tidak akurat. Berikut adalah dua 

keistimewaan analisis melalui SIG : 

a) Analisis Proximity 

Analisis Proximity merupakan suatu geografi yang berbasis 

pada jarak antar layer. Dalam analisis proximity SIG menggunakan 
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proses yang disebut dengan buffering, yaitu membangun lapisan 

pendukung sekitar layer dalam jarak tertentu untuk menentukan 

dekatnya hugungan antara sifat bagian yang ada. 

 

Gambar 2.1 Proximity Spasial 

b) Analisis Overlay 

Proses integrasi data dari lapisan-lapisan layer yang berbeda 

disebut dengan overlay. Secara analisis membutuhkan lebih dari 

satu layer yang akan ditumpang susun secara fisik agar bisa 

dianalisis secara visual. Dengan demikian, SIG diharapkan mampu 

memberikan kemudahan-kemudahan yang diinginkan yaitu: 

1) Penanganan data geospasial menjadi lebih baik dalam format 

baku  

2) Revisi dan pemutakhiran data menjadi lebih mudah 

3) Data geospasial dan informasi menjadi lebih mudah dicari, 

dianalisis dan direpresentasikan 

4) Menjadi produk yang mempunyai nila tambah 

5) Kemampuan menukar data geospasial 

6) Penghematan waktu dan biaya 

7) Keputusan yang diambil menjadi lebih baik 
23

. 
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Gambar 2.2 Overlay Spasial 

3. Pemetaan  

Pemetaan adalah ilmu yang mempelajari kenampakan muka bumi 

yang menggunakan suatu alat dan menghasilkan infomasi yang akurat 

24
.  Konsep pemetaan sebagai penyajian masalah dalam informasi peta, 

atau informasi itu adalah kerenggangan dalam membetulkan untuk 

penyajian kartografi, yang cenderung keruang fisik daripada fungsinya. 

Fungsi ruang itu tampak lebih dari hubungan langsung manusia 

dengan lingkungan. Penggambaran data yang terkumpul ke dalam 

bentuk peta secara optimum memerlukan pengetahuan tentang 

pembuatan dan penggambaran peta yang baik 
25

. 

 

Gambar 2.3 Pemetaan 
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4. Model Data 

Struktur data spasial dibagi dua yaitu model data raster dan model 

data vektor. Data raster adalah data yang disimpan dalam bentuk kotak 

segi empat (grid)/sel sehingga terbentuk suatu ruang yang teratur. Data 

vektor adalah data yang direkam dalam bentuk koordinat titik yang 

menampilkan, menempatkan dan menyimpan data spasial dengan 

menggunakan titik, garis atau area (polygon) 
23

. 

 

Gambar 2.4 Permodelan 

E. Manfaat Sistem Informasi Geografis (SIG) Bagi Kesehatan 

GIS bisa dimanfaatkan sebagai penentu penyebaran penderita 

penyakit, termasuk pola dan model penyebarannya. Selain itu, GIS dapat 

dimanfaatkan dalam menentukan penyebaran unit-unit rumah sakit atau 

puskesmas, sarana kesehatan, termasuk jumlah tenaga medis. WHO 

menyatakan bahwa di bidang kesehatan, pemanfaatan GIS antara lain 

sebagai penentu penyebaran geografis penyakit, penganalisis trend spasial 

dan temporal, termasuk memetakan populasi beresiko, stratifikasi faktor 

resiko, menilai distribusi sumber daya, merencanakan dan menentukan 

intervensi, termasuk sebagai pemonitor penyakit. 
26
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F. Kerangka Teori 

 

  

 

 

 

 

 

 

 

 

 

 

Gambar 2.5 Teori Simpul Penyebab Terjadinya Penyakit Diare 

Sumber : Achmadi (2009) 
27
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G. Diagram Alir 

Tahapan proses yang akan dilakukan dalam penelitian ini di 

gambarkan dalam diagram alir pada gambar 2.1 sebagai berikut : 

1. Peta Kasus Diare di Wilayah Kerja Puskesmas Lubuk Buaya.  

 

 

 

 

 

2. Peta Sarana Air Bersih di Wilayah Kerja Puskesmas Lubuk Buaya. 

 

 

 

 

 

3. Peta Sarana Jamban di Wilayah Kerja Puskesmas Lubuk Buaya. 
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4. Distribusi Spasial Kejadian Diare di Wilayah Kerjas Puskesmas Lubuk 

Buaya 

 

 

 

 

 

 

 

 

 

Gambar 2.6  Diagram Alir Penelitian 
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H. Definisi Opeasional 

No Variabel Definisi 

Operasional 

Alat Ukur Cara Ukur Hasil Ukur Skala 

Variabel Dependen 

1. Kejadian  

Diare Pada 

Balita 

Balita  yang 

menderita Diare 

Pada wilayah 

kerja 

Puskesmas 

Lubuk Buaya 

Dokumentasi 

Laporan kasus 

Diare di 

Puskesmas  

Observasi 

Data  

sekunder 

- Ordinal 

 

Variabel Independen 

1. Sarana  Air 

Bersih 

 

Sebaran Rumah 

yang 

dinyatakan 

menderita diare 

yang 

menggukanan 

sarana air 

bersih (Sumur 

Gali, Tangki 

penampungan 

air) 

Checklist 

 

Observasi 

Data 

Sekunder 

 

Skor risiko 

pencemaran 

bersadarkan 

pengamatan : 

AT = Amat 

Tinggi 

T = Tinggi 

S = Sedang  

R = Rendah 

Pewarnaan 

dalam analisis 

spasial akan 

diwarnai 

berdasarkan 

skor risiko 

yang peroleh. 

AT = Merah 

T = Kuning 

S = Oranye 

R = Hijau 

Ordinal 

2. Sarana 

Jamban 

Sarana 

bangunan atau 

sarana yang 

digunakan 

untuk 

membuang tinja 

atau kotoran 

manusia biasa 

disebut kakus / 

wc 

Checklist Observasi 

Data 

Sekunder 

Skor risiko 

Pencemaran 

bersadarkan 

pengamatan : 

T = Tinggi 

S = Sedang  

R = Rendah 

Pewarnaan 

dalam analisis 

spasial akan 

diwarnai 

berdasarkan 

skor risiko 

yang peroleh. 

AT = Merah 

T = Kuning 

Ordinal 
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S = Oranye 

R = Hijau 
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BAB III 

METODE PENELITIAN 

A. Jenis Penelitian 

Jenis penelitian yang digunakan dalam penelitian ini adalah 

penelitian deskriptif dengan studi observasional dari data sekunder 

Puskesmas Lubuk Buaya terkait kerjadian kasus diare yang terjadi 

sebelum dilakukannya penelitian ini  Juni - Juli 2023 di Wilayah Kerja 

Puskesmas Lubuk Buaya melalui analisi spasial berbasis Sistem Informasi 

Geografis (SIG) dengan metode overlay. 

B. Waktu dan Tempat Penelitian 

Penelitian ini dilakukan pada bulan Juli - Agustus 2023 di wilayah 

kerja Puskesmas Lubuk Buaya Kota Padang. 

C. Populasi dan Sampel 

1. Populasi 

Populasi pada penelitian ini adalah Balita yang berada di 

wilayah kerja Puskesmas Lubuk Buaya yang tercatat menderita 

penyakit Diare dan beralamat lengkap dengan sarana air bersih dan 

sarana jamban. 

2. Sampel 

Pengambilan sampel menggunakan teknik total sampling 

terhadap 22 balita dengan objek sebagai berikut : 

a) Lokasi rumah / titik koordinat rumah dari balita penderita diare di 

wilayah kerja Puskesmas Lubuk Buaya tahun 2022. 
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b) Sarana Air bersih yang digunakan oleh keluarga dari balita 

penderita diare di wilayah kerja Puskesmas Lubuk Buaya Tahun 

2022. 

c) Sarana Jamban yang digunakan oleh keluarga dari balita penderita 

diare di wilayah kerja Puskesmas Lubuk Buaya Tahun 2022. 

D. Teknik Pengumpulan Data 

1. Data Primer 

Data diperoleh dengan melakukan wawancara secara langsung 

dengan  pemilik rumah yang terdapat balita penderita diare, yang 

bersumber dari data laporan tahunan Puskesmas Lubuk Buaya 2022. 

2. Data Sekunder 

Data sekunder yang diperoleh dari data sekunder Puskesmas Lubuk 

Buaya adalah data terkait nama dan alamat balita penderita diare di 

wilayah kerja Puskesmas Lubuk Buaya. 

E. Instrumen Penelitian 

1. Lembar observasi 

berupa tabel yang akan digunakan untuk pengambilan data di 

lokasi penelitian. 

2. GPS (Field Maps by ESRI) 

digunakan untuk menentukan titik koordinat. 

3. Kamera  

Digunakan untuk mendokumentasikan saat pengambilan sampel. 
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4. Laptop 

Digunakan untuk mengalisis spasial data sebaran menggunakan 

aplikasi ArcGis 10.8 

F. Analisis Spasial 

Pada Penelitian ini, Analisi spasial ini dilakukan guna memberikan 

perbandingan tinggi, sedang atau rendah pada setiap kelurahan dengan 

metode Overlay yaitu dengan menggabungkan dua peta atau lebih dengan 

sistem tumpang susun secara digital sehingga mengahsilkan peta baru. 

Dalam analisis spasial ini dilakukan beberapa tahapan yaitu : 

1. Klasifikasi Data 

Dari data yang diperoleh yaitu data kejadian diare pada balita, 

diamati pada penyediaan air bersih, pengelolaan limbah cair. Dan 

pengelolaan limbah padat diklasifikasikan menjadi dua kelompok yaitu 

layak dan tidak layak 

2. Query 

Dari hasil pengklasifikasian data yang telah dilakukan, maka 

dilakukan proses dengan menggunakankan perangkat lunak untuk 

pelakukan pemilahan terhadap data yang akan di kelompokkan ke 

dalam kategori rendah, sedang, dan tinggi sehingga dihasilkan suatu 

peta tematik hasil dari perhitungan variabel-variabel. 

3. Peta (Layout) 

Pengklasifikasian data dan query menghasilkan output berupa peta 

sebaran kejadian diare pada balita, dengan sanitasi lingkungannya.  
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BAB IV 

HASIL DAN PEMBAHASAN 

A. Gambaran Umum Penelitian 

1. Geografis 

Wilayah kerja Puskesmas Lubuk Buaya terletak pada posisi 

100° 8‟ - 100° 21‟ LS, 0° 52' 30” LU - 0° 49' 30” , dengan Wilayah 

Kerja Berikut ini : 

a. Parupuk Tabing 

b. Batang Kubung Gantiang 

c. Lubuk Buaya 

d. Pasie Nan Tigo 

Dengan batas wilayah sebagai berikut : 

a. Utara berbatasan dengan Kelurahan Padang Sarai, Kelurahan 

Batipuh Panjang dan Kelurahan Katapiang 

b. Timur berbatasan dengan Kelurahan Koto Pulai dan Bungo Pasang 

c. Selatan berbatasan dengan Kelurahan Air Tawar Barat dan Air 

Tawar Timur 

d. Barat Berbatasan dengan Selat Mentawai 

Gambar 4.1 adalah visualisasi dari wilayah kerja Puskesmas Lubuk 

Buaya : 
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Gambar 4.1 Peta Wilayah Kerja Puskesmas Lubuk Buaya 

Pada legenda Gambar 4.1 menjelaskan Warna Oranye adalah 

wilayah administrasi Kelurahan Parupuk Tabing, Warna Merah Muda 

adalah wilayah admistrasi Kelurahan Batang Kabung Gantiang, Warna 

Ungu adalah wilayah administrasi Kelurahan Lubuk Buaya dan warna 

Coklat adalah wilayah administrasi Kelurahan Pasie Nan Tigo, serta garis 

menjelaskan Jalan. 

2. Demografi 

Wilayah kerja Puskesmas Lubuk Buaya memiliki luas wilayah 

59,13 KM
2
. Jumlah Penduduk 74.009 jiwa, dengan spesifikasi Perempuan 

36.990 jiwa, Laki – Laki 37.019, dengan jumlah Kepala Keluarga 23.315. 
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B. Hasil Penelitian 

Sebaran kasus Diare dilakukan pada 22 Balita yang tersebar di wilayah 

kerja Puskesmas Lubuk Buaya dengan 4 Kelurahan sebagai wilayah 

kerjanya. Berikut hasil yang diperoleh oleh peneliti. 

1. Sebaran Kasus Diare di Wilayah Kerja Puskesmas Lubuk Buaya 

Sebaran kasus Diare yang pada balita yang terdapat di wilayah 

kerja Puskesmas Lubuk Buaya, maka pada tabel 4.1 menjelaskan : 

Tabel 4.1 Sebaran Balita Penderita Diare 

No Kelurahan No Nama Penderita Jumlah 

1 Lubuk Buaya 

1 Samaran 1 

15 

2 Samaran 2 

3 Samaran 3 

4 Samaran 4 

5 Samaran 5 

6 Samaran 6 

7 Samaran 7 

8 Samaran 8 

9 Samaran 9 

10 Samaran 10 

11 Samaran 11 

12 Samaran 12 

13 Samaran 13 

14 Samaran 14 

15 Samaran 15 

 

2 Pasie Nan Tigo 1 Samaran 16 1 

 

3 Parupuk Tabing 

1 Samaran 17 

4 
2 Samaran 18 

3 Samaran 19 

4 Samaran 20 

 

4 
Batang Kabung 

Gantiang 

1 Samaran 21 
2 

2 Samaran 22 

Total  22 
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Dari Tabel 4.1 dapat dijelaskan bahwa Kelurahan Lubuk Buaya 

terdata 15 Balita yang menderita Diare , Kelurahan Pasie Nan Tigo 1 

Balita, Kelurahan Parupuk Tabing 4 balita, Kelurahan Batang Kubung 

Gantiang 2 Balita. Dengan total penderita adalah 22 Balita. Gambar 4.2 

memvisualisasikan sebaran Balita yang menderita Diare di 4 Kelurahan 

Wilayah Kerja Puskesmas Lubuk Buaya. Dibawah ini adalah Peta Sebaran 

Balita Penderita Diare di Wilayah Kerja Puskesmas Lubuk Buaya : 

 

Gambar 4.2 Peta Sebaran Penderita Diare 

Gambar 4.2 adalah Peta Sebaran Penderita Diare, titik Hitam 

menjelaskan lokasi Balita Penderita Diare. Terdapat 22 Balita yang 

menderita Diare, diantaranya 4 Balita berada pada wilayah Kelurahan 

Parupuk Tabing. 2 Balita pada wilayah Kelurahan Batang Kabun 
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Gantiang, 1 Balita pada wilayah Kelurahan Pasie Nan Tigo, dan 15 Balita 

pada Kelurahan Lubuk Buaya. 

2. Sebaran Sarana Air Bersih Balita Penderita Diare 

Sebaran Sarana Air Bersih Balita Penderita Diare pada Wilayah 

Kerja Puskesmas Lubuk Buaya , Maka pada tabel 4.2 menjelaskan : 

Tabel 4.2 Sebaran Sarana Air Bersih Penderita Diare 

No Nama Penderita Kelurahan 
Tingkat Risiko 

Pencemaran 

1 Samaran 1 

Lubuk Buaya 

Rendah 

2 
Samaran 2 

Tinggi 

3 Samaran 3 Rendah 

4 Samaran 4 Rendah 

5 Samaran 5 Rendah 

6 Samaran 6 Rendah 

7 Samaran 7 Rendah 

8 Samaran 8 Rendah 

9 Samaran 9 Rendah 

10 Samaran 10 Rendah 

11 Samaran 11 Rendah 

12 Samaran 12 Rendah 

13 Samaran 13 Rendah 

14 Samaran 14 Rendah 

15 Samaran 15 Rendah 

16 Samaran 16 

Parupuk 

Tabing 

Rendah 

17 
Samaran 17 

Tinggi 

18 Samaran 18 Rendah 

19 Samaran 19 Rendah 

20 Samaran 20 Batang Sedang 
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21 

Samaran 21 

Kabung 

Gantiang 

Tinggi 

 

22 

Samaran 22 
Pasie Nan 

Tigo 
Sedang 

Pada tabel 4.2 dijelaskan bahwa dari 22 Balita yang menderita 

Diare pada wilayah kerja Puskesmas Lubuk Buaya , 21 Rumah 

menggunakan sumur gali sebagai Sarana Air Bersih, 1 Rumah 

menggunakan PDAM. Pada tabel 4.2 terdapat 15 Balita yang menderita 

Diare di Kelurahan Lubuk Buaya diantaranya terdapat 1 rumah dengan 

tingkat risiko tinggi, 14 lainnya dengan tingkat risiko rendah, pada 

Kelurahan Parupuk Tabing terdapat 4 Balita yang menderita Diare, 1 

Balita dengan tingkat risiko tinggi, 3 diantaranya dengan tingkat risiko 

rendah, Pada Kelurahan Batang Kabung Gantiang terdapat 2 Balita yang 

menderita Diare, 1 Balita dengan tingkat risiko sedang dan 1 Balita dengan 

tingkat risiko tinggi. Pada Kelurahan Pasie Nan Tigo terdapat 1 Balita 

dengan tingkat risiko sedang. 

Berikut sebaran spasial berdasarkan tingkat risiko pencemaran 

pada wilayah kerja Puskesmas Lubuk Buaya : 
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Gambar 4.3 Peta Sebaran Sarana Air Balita Penderita Diare 

Pada Gambar 4.3, titik Kuning, Oranye, dan Hijau dapat 

dijelaskan dengan Balita Penderita Diare. Warna ungu menjelaskan 

Kelurahan Lubuk Buaya dengan jumlah Balita penderita Diare 

tertinggi dengan total 15 Balita. Warna Coklat menjelaskan Kelurahan 

Pasie Nan Tigo dengan jumlah Balita penderita diare yaitu 1 Balita. 

Warna Oranye menjelaskan Kelurahan Parupuk Tabing dengan jumlah 

Balita Penderita Diare yaitu 4 Balita. Warna Coklat Muda menjelaskan 

Kabung Gantiang dengan jumlah Balita Penderita Diare yaitu 2 Balita. 

Berikut klasifikasi tingkat risiko Rendah, Sedang dan Tinggi 

yang dapat dijelaskan dengan Peta Spasial. 

a. Sebaran Sarana Air Bersih Balita Penderita Diare Dengan 

Risiko Rendah 
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Gambar 4.4 adalah Peta Spasial Sebaran Sarana Air 

Bersih Balita Penderita Diare dengan Tingat Risiko 

Pencemaran Rendah. 

 

Gambar 4.4 Peta Sebaran Penderita Diare  

Dengan Risiko Rendah 

Gambar 4.4 menjelaskan bahwa Titik Hijau menjelaskan Balita 

Penderita Diare dengan klasifikasi Risiko Rendah. Warna Ungu 

menjelaskan Kelurahan Lubuk Buaya dengan Titik Hijau terbanyak di 

wilayah tersebut sebanyak 14 Balita, rumah Balita tersebut menggunakan 

sumber air bersih Sumur Gali, dengan bak septik menggunakan Sumur 

Cincin. sedangkan wilayah Kelurahan Parupuk Tabing atau Warna Coklat 

terdapat 3 Titik di wilayah tersebut, 2 Balita menggukan sumber air bersih 

Sumur Gali, dan 1 Balita menggunakan Sumber Air dari PDAM. 
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Rata-rata dari Balita Penderita Diare dengan Risiko Rendah 

tersebut diduga menderita diare karna jarak bak septik rumah Penderita 

tidak melebihi jarak minimal 10 M antara Sarana Air Bersih yaitu Sumur 

gali. 

b. Sebaran Sarana Air Bersih Balita Penderita Diare Dengan 

Risiko Sedang 

Gambar 4.5 adalah Peta Spasial Sebaran Sarana Air 

Bersih Balita Penderita Diare dengan Tingat Risiko 

Pencemaran Sedang. 

 

Gambar 4.5 Peta Sebaran Balita Penderita Diare 

Dengan Risiko Sedang 

 

Gambar 4.5 menjelaskan Titik Oranye terdapat pada Kelurahan 

Batang Kubung Gantiang  dan Kelurahan Pasie Nan Tigo yang 
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menjelaskan Balita Penderita Diare dengan Risiko Sedang. Sumber air 

yang digunakan oleh 2 Balita tersebut adalah Sumur Gali dan juga bak 

septik dengan sumur cincin. 

c. Sebaran Saran Air Bersih Balita Penderita Diare Dengan 

Risiko Tinggi 

Gambar 4.6 adalah Peta Sebaran Sarana Air Bersih 

Balita Penderita Diare dengan Risiko Tinggi 

 

Gambar 4.6 Peta Sebaran Balita Penderita Diare Dengan 

Risiko Tinggi 

 

Gambar 4.6 menjelaskan bahwa terdapat 3 Titik Kuning adalah 

Titik yang menandakan klasifikasi dengan Risiko Tinggi, yang tersebar di 

3 Kelurahan yaitu Parupuk Tabiang, Batang Kubung Gantiang, Dan Pasie 

Nan Tigo. 
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Dapat dijelaskan bahwa 1 Balita di Kelurahan Batang Kubung 

Gantiang menderita Diare setelah terjadi Banjir dan juga dapat 

diindikasikan dengan Air Sumur tercemar oleh limbah tangki septik. Balita 

pada Kelurahan Parupuk Tabing memiliki Sumur yang tidak memenuhi 

syarat karena jarak Sumur Gali dengan bak septik tidak 10 meter, juga 

sumber pencemar yang terdapat disekitar sumur seperti genangan air 

akibat kegiatan Mandi, Cuci dan Kakus, saluran pembuangan air limbah 

yang rusak, dan lantai yang tidak di semen. Balita pada Kelurahan Pasie 

Nan Tigo menderita Diare akibat banjir yang melanda Rumah Penderita 

Diare, air Sumur Gali yang bercampur dengan limbah yang terbawa oleh 

genangan air, serta jarak antara bak septik yang tidak melebihi minimal 

jarak 10 meter. 

3. Sebaran Sarana Jamban Balita Penderita Diare 

Sebaran kasus Diare yang dilakukan pada wilayah kerja Puskesmas 

Lubuk Buaya dapat dijelaskan pada tabel 4.3 

Tabel 4.3 Sebaran Jamban Balita Penderita Diare  

No Nama Penderita Kelurahan 
Tingkat 

Risiko Pencemaran 

1 Samaran 1 

Lubuk Buaya 

Sedang 

2 
Samaran 2 

Tinggi 

3 Samaran 3 Rendah 

4 Samaran 4 Sedang 

5 Samaran 5 Sedang 

6 Samaran 6 Sedang 

7 Samaran 7 Sedang 

8 Samaran 8 Sedang 

9 Samaran 9 Sedang 
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10 Samaran 10 Sedang 

11 Samaran 11 Sedang 

12 Samaran 12 Sedang 

13 Samaran 13 Sedang 

14 Samaran 14 Sedang 

15 Samaran 15 Sedang 

16 Samaran 16 

Parupuk 

Tabing 

Sedang 

17 
Samaran 17 

Tinggi 

18 Samaran 18 Sedang 

19 Samaran 19 Rendah 

20 Samaran 20 Batang 

Kabung 

Gantiang 

Sedang 

21 

Samaran 21 

Sedang 

 

22 
Samaran 22 Pasie Nan 

Tigo 
Sedang 

 Pada tabel 4.3 dijelaskan bahwa dari 22 Balita yang menderita Diare hanya 

1 balita yang Jamban dan Sumber Air Bersihnya dikategorikan dengan Risiko 

Rendah, 21 diantaranya memiliki masalah pada Sumber Air Bersih yang jarak 

antara bak septik tidak melebihi minimal jarak 10 meter dari sumber air bersih 

yaitu Sumur Gali, serta bak septik yang menggunakan sumur cincin. 
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  Visualisasi dari Sebaran Jamban Balita Penderita Diare dalam bentuk Peta 

Spasial dengan 3 kategori tingkat risiko pencemaran pada gambar 4.7 sebagai 

berikut : 

 

Gambar 4.7 Peta Sebaran Sarana Jamban Balita Penderita Diare 

 Gambar 4.7 menjelaskan bahwa Kelurahan Parupuk Tabing berwarna 

merah muda, Kelurahan Batang Kubung berwarna coklat muda, Kelurahan Pasie 

Nan Tigo berwarna coklat tua, Kelurahan Lubuk Buaya berwarna ungu. 

 Klasifikasi Faktor Risiko yaitu Titik warna Kuning adalah Tingkat Risiko 

Tinggi, Titik warna Oranye adalah Tingkat Risiko Sedang, Titik warna Hijau 

adalah Tingkat Risiko Rendah. Dibawah ini adalah visualisasi peta spasial sebaran 

dengan tingkat risiko pencemarannya : 
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a. Sebaran Sarana Jamban Balita Penderita Diare Dengan Faktor 

Risiko Tinggi 

Gambar 4.8 adalah Peta Spasial Sebaran Sarana Air Bersih 

Balita Penderita Diare dengan Tingat Risiko Pencemaran Tinggi. 

 

Gambar 4.8 Peta Sebaran Jamban Balita Penderita Diare Dengan  

Risiko Tinggi 

 

Gambar 4.8 menjelaskan ada 2 Balita yang menderita Diare yang 

berada pada Kelurahan Parupuk Tabing dan Kelurahan Lubuk Buaya. 

Balita yang berada pada Kelurahan Lubuk Buaya menggunakan jamban 

yang jaraknya kurang dari 10 meter dengan sumber air bersih yaitu Sumur 

Gali, lantai jamban yang tidak rapat, serta lantai licin dan tidak mudah 

dibersihkan. Balita pada Kelurahan Parupuk Tabing menggunakan jamban 

yang jaraknya kurang dari 10 meter dengan Sumur Gali sebagai sumber air 
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bersihnya, lantai yang tidak mengitari Sumur Gali serta lantai licin dan 

tidak mudah dibersihkan. 

b. Sebaran Sarana Jamban Balita Penderita Diare Dengan Risiko 

Sedang 

Gambar 4.9 adalah Peta Spasial Sebaran Sarana Air Bersih 

Balita Penderita Diare dengan Tingat Risiko Pencemaran Sedang. 

 

Gambar 4.9 Peta Sebaran Jamban Balita Penderita Diare Dengan 

Risiko Sedang 

 

Gambar 4.9 menjelaskan terdapat 18 balita yang terserbar di 4 

Kelurahan atau Wilayah Kerja Puskesmas Lubuk Buaya yang menderita 

diare. Kelurahan Parupuk Tabing terdapat 2 Balita Penderita Diare. 

Kelurahan Batang Kubung Gantiang terdapat 2 Balita Penderita Diare. 

Kelurahan Pasie Nan Tigo menjadi Kelurahan yang paling sedikit Balita 
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Penderita Diare yaitu 1 Balita. Kelurahan Lubuk Buaya menjadi 

Kelurahan yang paling banyak Balita Penderita Diare yaitu 13 Balita. 

c. Sebaran Sarana Jamban Balita Penderita Diare Dengan Risiko 

Rendah 

Gambar 4.10 adalah Peta Spasial Sebaran Sarana Air 

Bersih Balita Penderita Diare dengan Tingat Risiko Pencemaran 

Sedang. 

 

Gambar 4.10 Peta Sebaran Jamban Balita Penderita Diare Dengan 

Risiko Rendah 

 

  Gambar 4.10 menjelaskan ada 2 Balita menderita diare yang 

tersebar di 2 Kelurahan Wilayah Kerja Puskesmas Lubuk Buaya, yaitu pada 

Kelurahan Parupuk Tabing dan Kelurahan Lubuk Buaya. Balita pada Kelurahan 

Lubuk Buaya.  
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C. Pembahasan 

1. Kejadian Diare Pada Balita 

Hasil penelitian tabel 4.1 menjelaskah bahwa di wilayah kerja 

Puskesmas Lubuk Buaya, Balita yang paling banyak menderita Diare 

ada pada Kelurahan Lubuk Buaya yaitu 15 Balita, Kelurahan Parupuk 

Tabing 4 Balita, Kelurahan Batang Kubung Gantiang 2 Balita, dan 1 

Balita Pada Kelurahan Pasie Nan Tigo. 

Berdasarkan penelitian yang dilakukan Renata Philipa
28

 

mengenai Analisis Spasial Kejadian Diare pada Balita di Provinsi 

Sumatera Utara Tahun 2020 diketahui hasil analisis deskriptif 

menunjukan bahwa rata-rata insidens kumulatif diare pada balita di 

setiap kabupaten/kota di Sumatera Utara adalah 3,83% (standar deviasi 

2,85%). Hal ini didukung oleh penelitian oleh Dirza Ariya mengenai 

Gambaran Spasial Kejadian Diare Pada Balita Berdasarkan Kondisi 

Sanitasi Lingkungan Dan Personal Hygiene Di Wilayah Kerja 

Puskesmas Lempake Kota Samarinda diketahui data yang didapatkan 

Sebanyak 188 responden yang diteliti pada penelitian ini, dimana 

terdapat 72 balita yang menderita diare dan 166 balita tidak menderita 

diare. Sebagian besar balita yang didata pada penelitian ini memiliki 

rentang umur 3-4 tahun (51.1%)
29

. 

Peneliti berasumsi perilaku penjamah makanan memberikan 

pengaruh yang cuku besar dalam menjadi media perpindahan agen 

penyakit ke makanan yang selanjutnya masuk ke dalam tubuh 

manusia. Setiap ibu rumah tangga harus memiliki pengetahuan yang 
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baik tentang hygiene makanan minuman sehingga dapat 

menerapkannya di keluarga. Selain itu, pemilihan bahan makanan juga 

turut berpengaruh terhadap dalam menyediakan makanan yang sehat 

kepada balita. Bahkan cara penyujian peralatan makan juga dapat 

mempengaruhi kualitas higienitas makanan yang diolah. Maka dari itu, 

para ibu rumah tangga harus memperhatikan perilaku pengolahan 

makanan khususnya untuk makanan balitanya. Selain aspek cara 

pengelolaan makanan minuman, perilaku ibu rumah tangga dalam 

mengolah sampah yang ada di sekitar rumah juga dapat memberikan 

pengaruh terhadap kejadian diare. 

2. Sarana Air Bersih 

Hasil penelitian pada tabel 4.2 menjelaskan bahwa dari 22 

balita yang menderita Diare, 17 Balita dengan klasifikasi tingkat risiko 

pencemaran Rendah, 16 Balita menggunakan Sumur Gali sebagai 

sarana air bersih dan 1 balita menggukana PDAM sebagai sarana air 

bersih. 

Sedangkan klasifikasi tingkat risiko pencemaran Sedang 

terdapat 2 balita yang menggunakan Sumur Gali sebagai sarana air 

bersih. Serta 3 balita dengan tingkat risiko pencemaran tinggi 

menggunakan Sumur Gali sebagai sarana air bersih. 

Distribusi Spasial terdapat pada Gambar 4.7 dengan keterangan 

Legenda sebagai berikut : 

a. Rendah = Titik Hijau 

b. Sedang = Titik Oranye 
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c. Tinggi = Titik Kuning 

Penelitian yang dilakukan oleh Hanan Lanang mengenai 

Analisis Spasial Kejadian Diare dengan Keberadaan Sumur Gali di 

Kelurahan Jabungan Kota Semarang Hasil pemeriksaan pada air 

sumur gali menunjukkan bahwa semua air sumur yang diperiksa 

mengandung bakteri Coliform dan hanya 4 sumur dengan total 

Coliform yang menunjukkan nilai ≤50 CFU/100 ml yang mengartikan 

hanya 4 sumur yang memenuhi persyaratan untuk dijadikan sebagai 

air bersih. Hasil pemeriksaan tersebut mengindikasikan bahwa air 

sumur yang ada di Kelurahan Jabungan telah terkontaminasi oleh 

kotoran manusia atau hewan yang dapat menyebabkan penyakit-

penyakit saluran pencernaan seperti diare
30

.  

Hal ini membuktikan serta peneliti berasumsi bahwa Kegiatan 

yang perlu dilakukan adalah mengidentifikasi sumber kontaminasi 

mikrobiologis dengan mempertimbangkan karakteristik hidrogeologis 

dari lokasi pengambilan sampel. Dengan dilakukan kegiatan 

identifikasi di sumber kontaminasi, diharapkan dapat menemukan 

solusi yang paling benar dan tepat untuk menyelesaikan permasalahan 

kualitas air yang ada di daerah ini. Pencegahan pencemaran sumur gali 

oleh bakteri coliform yang harus diperhatikan adalah jarak sumur 

dengan jamban, septictank dan sumber-sumber pencemar lainnya. 

Jarak yang aman antara sumur dengan sumur pencemar seperti jamban 

adalah tidak kurang dari 11 meter dan diusahakan agar letaknya tidak 

berada di bawah tempat sumber pencemar tersebut. Adanya jarak 
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antara sumur gali dengan jamban adalah >11 meter bertujuan untuk 

mencegah bakteri yang terbawa oleh air masuk ke dalam air sumur 

gali. Keberadaan jamban dengan sumur yang jaraknya masih berada 

dalam kurang dari radius 11 meter dapat mempermudah adanya 

pencemaran coliform terhadap sumber air tanah. Jarak jamban yang 

berdekatan dengan sumur gali dapat mencemari air sumur dengan 

Escherichia coli. Faktor yang dapat mempengaruhi pencemaran 

tersebut adalah dikarenakan luas lahan yang terbatas dan bangunan 

jamban yang tidak kedap air serta porositas dan permeabilitas tanah 

yang dapat mempengaruhi laju infiltrasi air sehingga dapat 

mempengaruhi penyerapan bakteri tersebut.  

Kualitas bakteriologis air sangat dipengaruhi oleh jarak sumber 

air dengan sumber pencemaran, karena kemampuan bakteri bergerak 

dalam sehari untuk mencapai sumber air menentukan kehidupan 

bakteri. Bakteri yang dapat mencapai sumber air sebelum batas waktu 

hidup bakteri, dapat mempengaruhi kualitas air. Keadaan ini dapat 

menularkan diare melalui media air, atau media makanan yang 

terkontaminasi oleh E.coli, Entamoeba hystolitica, Sygella, vibrio 

cholera, dan lain-lain agent penyebab pennyakit. 

3. Sarana Jamban 

Hasil Penelitian pada tabel 4.3 menjelaskan bahwa 22 balita 

yang menderita Diare, 2 balita dengan tingkat risiko pencemaran 

rendah pada sarana jambannya. Balita tersebut beralamat pada wilayah 

administrasi Kelurahan Lubuk Buaya dan Parupuk Tabing. 
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Sedangkan dengan klasifikasi tingkat risiko pencemaran 

Sedang pada sarana jambannya terdapat 18 balita. Terbagi pada 

wilayah administrasi Kelurahan Lubuk Buaya sebanyak 13 balita, 

wilayah administrasi  Kelurahan Parupuk Tabing sebanyak 2 balita, 

wilayah administrasi Kelurahan Batang Kabung Gantiang sebanyak 2 

balita dan 1 balita pada wilayah administrasi Kelurahan Pasie Nan 

Tigo. 

Distribusi Spasial Sebaran Sarana Jamban terdapat pada 

gambar 3.2 dengan Legenda sebagai berikut : 

a. Rendah = Titik Hijau 

b. Sedang = Titik Oranye 

c. Tinggi = Titik Kuning  

Berdasarkan  penelitian yang dilakukan Etta Rahmatasari 

mengenai Pola Spasial Kasus Diare pada Balita Berdasarkan Faktor 

Lingkungan dan Perilaku Hidup Sehat di Wilayah Kerja Puskesmas 

Lempake Kota Samarinda diketahui bahwa balita yang tidak diare 

lebih berisiko untuk diare (40%) pada masyarakat dengan kondisi 

jamban sehat memenuhi syarat. Sedangkan balita yang tidak diare 

(64%) hasil uji statistik chi-square diperoleh nilai p value= 0,062> 

0,05 hal ini menunjukkan bahwa tidak ada hubungan antara kondisi 

jamban dengan kejadian diare di wilayah kerja puskesmas lempake 

kota samarinda
31

. 

Kementerian Kesehatan Republik Indonesia telah 

mengeluarkan peraturan terkait persyaratan jamban keluarga yang 
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sehat. Salah satu syarat yang harus dipenuhi yaitu jarak septik tank 

pada jamban harus berjarak lebih dari 10 meter dari sumber air. Jika 

tidak memenuhi standar tersebut maka berisiko tercemar bakteri E. 

Coli yang berasal dari tinja manusia. Selain itu, ketersediaan air bersih 

dan sabun juga menjadi kriteria sebuah jamban sehat. Program STBM 

harus dimaksimalkandalam menumbuhkan kesadaran masyarakat agar 

menyiapkan jamban sehat di keluarga mereka. Salah satu pilar STBM 

yang terkait jamban sehat yaitu menghentikan kebiasaan buang air 

besar sembarangan seperti di sungai. Pemerintah harus melibatkan 

seluruh elemen masyarakat dalam memaksimalkan pelaksanaan 

STBM khususnya di rumah tangga. 



 

 

51 

 

BAB V 

KESIMPULAN DAN SARAN 

A. Kesimpulan  

1. Sebaran kejadian diare pada balita di wilayah kerja Puskesmas Lubuk 

Buaya Kota Padang Tahun 2023 menunjukkan bahwa 22 Balita 

dengan berbagai Risiko yaitu Tinggi, Sedang, dan Rendah, dengan 

klasifikasi Tinggi berwarna kuning, klasifikasi Sedang berwarna 

oranye, dan Klasifikasi Rendah berwarna hijau, yang tersebar di 

wilayah kerja Puskesmas Lubuk Buaya, yaitu Kelurahan Lubuk 

Buaya, Kelurahan Pasie Nan Tigo, Kelurahan Batang Kabung 

Gantiang, dan Kelurahan Parupuk Tabing. 

2. Sebaran sarana air bersih pada rumah balita penderita Diare di wilayah 

Kerja Puskesmas Lubuk Buaya Kota Padang Tahun 2023 adalah 

Sumur Gali,1 Balita dengan Sarana Air Bersih PDAM ( Perusahaan 

Daerah Air Minum) . Dari Sarana Air Bersih Sumur Gali yang 

digunakan oleh balita tersebut terdapat 16 Sumur Gali dengan tingkat 

risiko pencemaran Rendah,1 balita dengan sarana air bersih PDAM 

dengan tingkat risiko pencemaran rendah. 2 balita dengan sarana air 

bersih sumur gali dengan tingkat risiko pencemaran Sedang, dan 3 

balita dengan sarana air bersih dengan tingkat risiko pencemaran 

Tinggi.   

3. Sebaran sarana  jamban pada rumah balita penderita Diare di wilayah 

kerja Puskesmas Lubuk Buaya Tahun 2023 dengan klasifikasi tingkat 

risiko pencemaran pada balita yang menderita Diare adalah 2 balita 
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dengan tingkat risiko pencemaran Rendah, 18 balita dengan tingkat 

risiko pencemaran Sedang, dan  2 balita dengan tingkat risiko 

pencemaran Tinggi. 

B. Saran 

1. Bagi Puskesmas Lubuk Buaya 

a. Dalam penulisan alamat pasien supaya dapat diperhatikan, supaya 

memudahkan petugas untuk dapat mengunjungi rumah pasien 

untuk penanganan lebih lanjut, serta memudahkan petugas 

memvisualisasikan melalui Peta. 

b. Meningkatkan klasifikasi dalam pendataan pasien penyakit 

menular, seperti kasus diatas sangat diperlukan data inspeksi sarana 

jamban dan sarana air bersih. 

2. Bagi Masyarakat 

b. Air Bersih 

1) Balita penderita Diare dengan tingkat risiko pencemaran 

rendah supaya dapat memperhatikan sarana air bersih yang 

digunakan sebagai air minum contohnya dengan merebus air 

sampai dengan mendidih, karena pencemaran dengan tingkat 

risiko rendah rata-rata memiliki sarana air bersih yang jaraknya 

kurang dari 10 meter yang diindikasikan sarana air bersih 

tercemar bakteri yang menyebabkan Diare. 

2) Balita penderita Diare dengan tingkat risiko pencemaran 

sedang supaya dapat melakukan perbaikan dan pembangunan 

sarana air bersih dan jamban. 
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3) Balita penderita Diare dengan tingkat risiko pencemaran tinggi 

, peneliti menyarakan agar dapat membuat bak septik secara 

komunal, supaya sumber sarana air bersih dapat terjamin tidak 

tercemar bakteri. 

c. Sarana Jamban 

1) Balita penderita Diare dengan tingkat risiko pencemaran 

rendah disarankan agar memiliki bak septik sebagai 

penampung tinja yang dihasilkan, supaya tidak tercemar ke 

sumber air bersih yaitu sumur gali. 

2) Balita penderita Diare dengan tingkat risiko pencemaran 

sedang agar dapat memperbaiki bak septik yang awalnya 

cincin dengan bata merah atau batako, supaya tidak terjadi bak 

septik yang bocor dan dapat mencemari sumber air bersih yaitu 

sumur gali. 

3) Balita penderita Diare dengan tingkat risiko pencemaran tinggi 

, peneliti menyarakan agar dapat membuat bak septik secara 

komunal, supaya sumber sarana air bersih dapat terjamin tidak 

tercemar bakteri.  

3. Bagi Mahasiswa 

Menambahkan pengetahuan tentang Diare, Sarana Air Bersih, 

Sarana Jamban, dan Spasial untuk pemetaan atau visualisasi lebih 

lanjut. Serta sebagai dasar untuk pengembangan penelitian tentang 

Kejadian Kasus Diare berbasis spasial. 
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DAFTAR LAMPIRAN 

 

Lampiran A 

 

Langkah-Langkah Pembuatan Arcgis 

a. Menjalankan Program 

Buka aplikasi ArcMap → Klik start → Ketik ArcMap atau Klik All 

Program → Esri →ArcMap 10.2 → Klik atau Enter. 

 

Gambar 2.1 Mencari Aplikasi 

b. Membuat Lembar Kerja Baru 

Setelah aplikasi terbuka → Pilih Blank Map lalu Klik OK → Klik Add 

Data  → Pilih peta yang akan didigitasi 

.  

Gambar 2.2 Memasukan Peta 



 

 

 

 

Setelah peta telah dimasukan dilanjutkan dengan memasukan titik 

koordinat → Klik Add Control Point 

 → Klik kiri pada 

bagian titik koordinat pada peta → Klik kanan pilih Input DMS of Lon 

and Lat  → Masukan titik Koordinat sesuai 

dengan urutan yang telah di tandai. Jika gagal ex. Gambar miring atau 

hilang, ulangi memasukan titik koordinat (Bisa karena posisi peletakan 

titik yang salah atau karena titik koordinat yang tertukar). 

 

 

Gambar 2.3 Memasukan Titik Koordinat 

Setelah dimasukan titik koordinat selanjutnya menyimpan titik 

koordinat → Klik Georeferencing → Klik Update Georeferencing. 

 



 

 

 

 

 

Gambar 2.4 Update Titik Koordinat 

c. Membuat Shapefile Baru 

Setelah berhasil mengupdate titik koordinat (Update Georeferencing) 

selanjutnya adalah memulai digitasi. Langkah pertama adalah 

membuat Shapefile baru → Buat Shapefile baru dengan ArcCatalog, 

bisa melalui program atau menggunakan toolbars di ArcMap. 

 

Gambar 2.5 Catalog di Toolbars ArcMap 

 

Gambar 2.6 ArcCatalog di Program Start 



 

 

 

 

Setelah membuka aplikasi ArcCatalog atau Toolbars Catalog (pada 

Aplikasi ArcMap) → Pilih di folder mana kita akan menaruh Shapefile 

baru kita. 

 

Gambar 2.7 Pemilihan Folder Untuk Shapefile Baru Pada 

ArcCatalog 

 

 

Gambar 2.8 Pemilihan Folder Untuk Shapefile Baru Pada  

Toolbars Catalog 

 



 

 

 

 

Setelah kita telah menentukan di folder mana kita akan menaruh 

Shapefile baru kita selanjutnya adalah → Klik Kanan pada folder yang 

terpilih → Pilih New → Pilih Shapefile. (Berlaku juga untuk yang 

akan membuat Shapefile baru melalui toolbars di ArcGis).  

 

 

Gambar 2.9 Pembuatan Shapefile Baru 

Pada bagian name isi dengan nama Shapefile apa yang akan kita buat 

ex. Guna_Lahan → pada bagian Feature Type bisa disesuaikan dengan 

apa yang sekiranya akan kita buat. Feature Type Point untuk membuat 

Landmark atau tanda, Polygon untuk membuat guna lahan atau hal lain 

yang sekiranya membentuk suatu kawasan, dan Polyline untuk 

membuat jalan atau batas administrasi atau hal-hal lain sekiranya 

hanya berbentuk garis. 



 

 

 

 

 

Gambar 2.10 Pengisian Informasi Shapefile 

 

 

Setelah mengisi kolom Name dan Feature Type klik Edit → Klik 

Geographic Coordinate System → Klik World → Klik WGS 1984 → 

Klik OK → Klik OK lagi.



 

 

 

 

 

 

Gambar 2.11 Penentuan Dasar Koordinat Yang Digunakan 

 

d. Menambahkan Keterangan Pada Attribute Table 

Setelah berhasil membuat Shapefile baru kita harus menambahkan 

kolom keterangan pada Shapefile untuk memberikan keterangan pada 

digitasi kita nanti. Setelah Shapefile baru di buat, kita masukan 



 

 

 

 

Shapefile tersebut ke lembar kerja kita (Aplikasi ArcMap) dengan cara 

Klik Add Data (sama seperti saat memasukan peta dasar) → Cari 

folder yang kita telah buat Shapefile tadi didalamnya → Klik Add → 

Setelah Shapefile baru tadi masuk ke lembar kerja Klik kanan pada 

Shapefile tersebut lalu pilih Open Attribute Table → Table Option → 

Klik Add Field → Pada kolom Name di isi sesuai kebutuhan → Pada 

kolom Type di isi sesuai kebutuhan juga. Type Integer untuk pengisian 

bertipe angka, Type Text untuk pengisian bertipe huruf → Klik OK→ 

Close Windows Table. 



 

 

 

 

 

Gambar 2.12 Penambahan Kolom Keterangan 

e. Memulai Digitasi 

Setelah membuat keterangan kita telah siap melakukan digitasi pada 

peta. 

 



 

 

 

 

Langkah pertama adalah, Klik Editor → Klik Start Editing → Pada 

Windows Create Features (Jika Windows Create Features tidak 

muncul, klik Editor lagi, pilih Editing Windows lalu Klik Create 

Features) Klik Guna_Lahan (atau nama Shapefile yang kita buat di 

awal) → Klik Polygon. 

 

Gambar 2.13 

Memulai Digitasi 1 

Setelah mengklik Polygon baru kita memulai digitasi pada peta dasar. 

Klik kawasan mana pada peta dasar yang ingin kita digit → Setelah 

selesai pada satu kawasan, Double Klik pada akhir digitasi → Jika 

dirasa sudah cukup Klik Editor lalu Stop Editing, jika ingin 

melanjutkan dapat langsung mengklik lagi pada kawasan yang kita 



 

 

 

 

ingin digitasi. (Jika kita klik Stop Editing maka akan muncul Windows 

Save untuk editing, Klik yes jika kita ingin menyimpan hasil digitasi 

pada Shapefile, Klik no jika tidak, Klik cancel jika ingin melanjutkan 

digitasi.) 

 

Gambar 2.14 

Memulai Digitasi 2 

a) Pemberian Nama Pada Hasil Digitasi 

Setelah kita selesai mendigitasi, kita dapat memberikan keterangan 

pada hasil digitasi kita. Klik kanan pada Shapefile Guna_Lahan (atau 

nama Shapefile yang kita buat sendiri) lalu klik Attribute Table lagi → 

Pada Kolom Keterangan tulis guna lahan apa yang ada pada kawasan 

yang kita digitasi tadi (sebelum memberikan keterangan, pastikan kita 

sudah dalam kondisi Start Editing pada toolbars Editor) → Setelah 

selesai, Klik Editor lagi → Klik Stop Editing → „Save‟ Klik Yes. 



 

 

 

 

 

Gambar 2.15 Memberikan Keterangan Pada Digitasi 

Setelah diberikan keterangan, Klik kanan pada Shapefile lalu Klik 

Properties → Pada Layer Properties Klik Categories → Pada kolom 

Value Field ganti ke Keterangan → Klik Add All Values → Unceklist 

pada <all other values> → Pada Pemukiman Klik kanan lalu pilih 

Properties for selected symbols jika ingin mengganti warna dan Klik 

edit symbols pada selected symbols jika ingin mengganti garis tepi → 

Klik OK. 



 

 

 

 

 

Gambar 2.16 Memasukan Keterangan Pada Windows Properties 

 

Gambar 2.17 Mengganti Warna Untuk Kawasan Digitasi 

Setelah dirasa cukup Klik Labels pada Windows Properties → Ceklist 

pada Label features in this layers → Rubah Label Field ke Keterangan 

Klik OK. 



 

 

 

 

b) Membuat Layout 

Setelah proses digitasi selesai selanjutnya adalah pembuatan tampilan 

layout, yang harus dilakukan pertama adalah pengaturan orientasi 

kertas, pengaturan orientasi kertas tergantung pada kebutuhan atau 

tampilan petanya sendiri apakah portrait atau landscape. Langkahnya 

adalah klik file → Klik Page and Print setup → Pada bagian 

orientation ubah sesuai kebutuhan. 

 

Gambar 2.18 Pengaturan Page Orientation 

Setelah orientasi kertas selesai di atur, berikutnya adalah pembuatan 

garis tepi pada layout peta. Klik insert → Pilih dan klik Neatline → 

Klik Place Inside Margins → Klik OK → Sesuaikan Neatline yang 

telah di buat sesuai dengan ukuran kertas → Kemudian Copy Neatline 



 

 

 

 

tersebut dan bentuk kurang lebih seperti contoh di bawah (atau sesuai 

dengan keinginan). 

 

Gambar 2.19 Cara Membuat Neatline 

Gambar 2.20 Contoh Tampilan Peta 

Setelah membuat tampilan peta, selanjutnya adalah memberi nama 

pada peta. Klik Insert → Pilih dan Klik Text → Double Klik pada text 

yang ada → Ketikan nama peta → Untuk merubah ukuran, klik pada 

 → 

Klik OK. 



 

 

 

 

 

Gambar 2.21 Mengubah Text 

Setelah memberikan nama pada peta, berikutnya adalah membuat arah 

mata angin dan skala (scale bar dan scale text). Klik Insert → Pilih 

North Arrow → Double Klik pada gambar North Arrow yang akan 

kita pakai 

 

Gambar 2.22 Windows North Arrow 

Klik Insert → Pilih dan Klik Scale Bar → Double Klik pada Scale Bar 

yang kita akan gunakan. 



 

 

 

 

 

Gambar 2.23 Windows Scale Bar 

Klik Insert → Pilih dan Klik Scale Text → Double Klik pada Scale 

Text yang kita akan gunakan. 

 

Gambar 2.24 Windows Scale Text 



 

 

 

 

Setelah membuat nama peta, panah utara dan skala berikutnya adalah  

   

Gambar 2.25 Pemilihan Shapefile Yang Akan Dikeluarkan 

Legendanya 

memasukan legenda pada peta. Pilih dan Klik Insert → Klik Legend 

→ Keluarkan semuanya dari  Legend Item dengan mengklik   → 

Masukan Shapefile mana saja  yang akan kita  keluarkan legendanya  

dengan mengklik   → Klik Next sampai Finish. Setelah muncul 

Legend pada lembar kerja, Klik kanan pada Legend tersebut → Pilih 

dan Klik kiri pada Convert to graphics → Klik kiri lagi → Pilih dan 

Klik kanan pada Ungruop → Double Klik pada text keterangan → 

Ganti tulisannya sesuaikan dengan Legendanya. 

 

Gambar 2.26 Legend Pada Lembar Kerja 

Setelah selesai dengan legenda, terakhir adalah memasukan nama 

pembuat dan sumber si peta tersebut. Klik Insert → Klik Picture → 



 

 

 

 

Masukan gambar/logo/watermark kita → Klik Insert → Klik Text → 

Tulis nama kita/perusahaan/instansi → Copy text 

nama/perusahaan/instansi tersebut → Ganti tulisannya menjadi 

Sumber → Susun kurang lebih seperti contoh di bawah ini. 

 

Gambar 2.27 Contoh Nama Pembuat dan Sumber 

Setelah memasukan nama pembuat dan sumber, selanjutnya adalah 

pembuatan grid pada peta. Langkah pertama adalah klik peta dasar → 

Klik kanan pilih Properties → Klik New Grid → Klik Next sampai 

Finish. 

 

Gambar 2.28 Cara Membuat Grid 



 

 

 

 

Setelah menambahkan grid, sekarang kita akan mengatur ukuran grid 

tersebut. Jika windows Data Frame Properties masih terbuka maka kita 

lanjutkan dengan mengklik Properties, jika sudah tertutup klik kanan 

pada peta dasar dan klik properties → Pada Windows Reference 

System Properties klik tab Intervals → Sesuaikan angka interval 

dengan grid pada peta dasar (N.B nilai interval pada X Axis harus 

sama dengan Y Axis). 

 

Gambar 2.29 Pengaturan Interval Grid 



 

 

 

 

Langkah finishing tambahan jika kita sudah memiliki Shapefile 

kelurahan atau kecamatan wilayah kita adalah membuat peta kecil 

sebagai pemberitahu dimana lokasi wilayah yang kita digitasi. Klik 

insert → Klik Data Frame → Setelah muncul New Data Frame Klik 

kanan New Data Frame yang ada pada Table of Content → Pilih dan 

Klik Add Data → Pilih Shapefile kelurahan atau kecamatan kita → 

Klik kanan pilih Properties → Klik Categories → Rubah Value Field 

ke 

Field → Klik salah satu nama digitasi yang sudah ada di Shapefile 

yang kita punya → Tekan „Ctrl+A‟→ Unselect untuk „heading‟ → 

Klik kanan pada salah satu nama digitasi → Pilih dan Klik Properties 

for selected symbols → Rubah warnanya ke putih → Klik OK → Klik 

kiri pada nama kelurahan atau kecamatan yang sudah di 

digitasi/wilayah yang kita digitasi → Klik kanan pilih Properties for 

selected symbols → Rubah warnanya ke merah. 

 

Gambar 2.30 Peta Hasil 

Mengeksport Peta ke Gambar (JPEG) 

Tahap terakhir yaitu membuat peta ke format JPEG.  



 

 

 

 

 

 

Gambar 2.31 Peta Akhir Berformat JPEG 

Setelah peta selesai dan dirasa cukup, selanjutnya kita klik file → Pilih 

dan Klik Eksport Map → Klik OK. 

 

  



 

 

 

 

Lampiran B 

FORMULIR INSPEKSI SANITASI 

JAMBAN KELUARGA 

I. DATA UMUM 

1. Nama Balita  : ........................................ 

2. Alamat   : ........................................ 

3. Tanggal Kunjungan : ........................................ 

 

II. JENIS JAMBAN YANG DIMILIKI 

1. Tidak ada       

2. Cemplung tanpa tutup 

3. Cemplung dengan tutup 

4. Plengsengan 

5. Leher Angsa tanpa septiktank 

6. Leher Angsa dengan tank septik dan resapan 

 

III. URAIAN DIAGNOSA TINGKAT RISIKO PENCEMARAN 

No PERTANYAAN YA TIDAK 

1 Jarak cubluk / resapan kurang dari 10 meter 

dari sumur 

  

2 Lantai jamban tidak rapat, sehingga 

memungkinkan serangga dan binatang penular 

penyakit dapat masuk ke dalam cubluk / 

resapan serta menimbulkan bau 

  

3 Lubang masuk kotoran terbuka / bukan closet   

4 Jamban belum dilengkapin dengan rumah 

jamban 

  

5 Lantai licin dan tidak mudah dibersihkan   

6 Apakah menhole tidak dilengkapin dengan 

penutup 

  

7 Apakah penutup menhole tidak dikunci 

(digembok) dengan baik? 

  

8 Apakah semua bagian yang terbuka (ventilasi) 

tidak terlindung terhadap masuknya 

serangga/binatang? 

  

 Jumlah Jawaban YA   

 

PENILAIAN FAKTOR RISIKO : 

Tingkat risiko tinggi (T) = Bila jumlah jawaban Ya : 5 – 7 atau 

Bila jumlah jawaban Ya : 1 – 4, tapi terdapat 

pada nomor 1 dan 2 

Tingkat risiko Sedang (S) = Bila jumlah jawaban Ya : 1 – 4 tapi tidak 

terdapat pada nomor 1 dan 2 

Tingkat risiko Rendah (R)= Bila jumlah jawaban Ya : 0 

GPS : 

   ........................................  

 Petugas Inspeksi Sanitasi  



 

 

 

 

FORMULIR INSPEKSI SANITASI 

JENIS SARANA  : Sumur Gali 

I. Keterangan Umum 

1 Lokasi : 

2 Tanggal kunjungan :  

3 Nama Penderita :  

II. Diagnosa Khusus 

No PERTANYAAN Ya Tidak 

1 Apakah ada jamban pada radius 10 m disekitar 

sumur? 

  

2 Apakah ada sumur pencemar lain pada radius 10 

m disekitar sumur, misalnya kotoran hewan, 

sampah, genangan air, dll? 

  

3 Apakah ada/sewaktuwaktu ada genangan air 

pada jarak 2 (dua) meter sekitar sumur ? 

  

4 Apakah saluran pembuangan air limbah 

rusak/tidak ada? 

  

5 Apakah lantai semen yang mengitari sumur 

mempunyai radius kurang dari 1 (satu) meter? 

  

6 Apakah ada/sewaktu-waktu ada genangan air 

diatas lantai semen sekeliling sumur? 

  

7 Apakah didaerah hulu intake digunankan 

sebagai tempat limpahan air dari hasil kegiatan 

peternakan? 

  

8 Apakah ember dan tali timba diletakkan 

sedemikian rupa sehingga memungkinkan 

pencemaran? 

  

9 Apakah bibir sumur (cincin) tidak sempurna 

sehingga memungkinkan air merember kedalam 

sumur? 

  

10 Apakah dinding semen sedalam 3 (tiga) meter 

dari atas permukaan tanah tidak diplester cukup 

rapat/tidak sempurna? 

  

 JUMLAH   
Skor resiko pencemaran : 8 – 10 : Amat Tinggi (AT) 

 6 – 7 : Tinggi (T) 
 3 – 5 : 

0 - 2 : 
Sedang (S) 
Rendah (R) 

GPS :   



 

 

 

 

Lampiran C 

 

 Gambar Sumur Gali 

 

 

  



 

 

 

 

 

 Gambar jamban 

 

 

 

 

 

 

 

 

 

 

 Gambar bak septik  

  



 

 

 

 

Lampiran D 

 

 

 

  



 

 

 

 

 

 

 

  

  



 

 

 

 

Lampiran E 

Rekap Formulir Inspeksi Sanitasi  

Sarana Air Bersih 

No Nama Sarana Air 

Bersih 

Poin Faktor 

Risiko 

GPS 

1 Samaran 1 Sumur Gali 2 Rendah 100.326726 - 

0.827283 

2 Samaran 2 Sumur Gali 6 Tinggi 100.318849 - 

0.824032 

3 Samaran 3 Sumur Gali 1 Rendah 100.318716 - 

0.823677 

4 Samaran 4 Sumur Gali 1 Rendah 100.326349 - 

0.830332 

5 Samaran 5 Sumur Gali 1 Rendah 100.316347 – 

0.832769 

6 Samaran 6 Sumur Gali 1 Rendah 100.326037 – 

0.836315 

7 Samaran 7 Sumur Gali 1 Rendah 100.324953 – 

0.824436 

8 Samaran 8 Sumur Gali 1 Rendah 100.320054 – 

0.825964 

9 Samaran 9 Sumur Gali 1 Rendah 100.321468 – 

0.831811 

10 Samaran 10 Sumur Gali 1 Rendah 100.317505 – 

0.819096 

11 Samaran 11 Sumur Gali 1 Rendah 100.328711 – 

0.832819 

12 Samaran 12 Sumur Gali 1 Rendah 100.325806 – 

0.829154 

13 Samaran 13 Sumur Gali 1 Rendah 100.32813 – 0.828914 

14 Samaran 14 Sumur Gali 1 Rendah 100.328455 – 

0.829409 

15 Samaran 15 Sumur Gali 2 Rendah 100.32207 – 0.814865 

16 Samaran 16 Sumur Gali 1 Rendah 100.343937 – 

0.871859 

17 Samaran 17  Sumur Gali 6 Tinggi 100.348792 – 

0.882324 

18 Samaran 18 Sumur Gali 1 Rendah 100.342744 – 

0.870865 



 

 

 

 

19 Samaran 19 PDAM 1 Rendah 100.346205 – 

0.869071 

20 Samaran 20 Sumur Gali 5 Sedang 100.3303028 – 

0.947725 

21 Samaran 21 Sumur Gali 6 Tinggi 100.336147 – 

0.853861 

22 Samaran 22 Sumur Gali 4 Sedang 100.330302 – 

0.852275 

 

  



 

 

 

 

Lampiran F 

Rekap Formulir Inspeksi Sanitasi  

Sarana Jamban 

No Nama Sarana 

Jamban 

Poin Faktor 

Risiko 

Pencemaran 

GPS 

1 Samaran 1 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.326726 - 

0.827283 

2 Samaran 2 Leher Angsa 

dengan tangki 

septik dan 

resapan 

4 Tinggi 100.318849 - 

0.824032 

3 Samaran 3 Leher Angsa 

dengan tangki 

septik dan 

resapan 

4 Rendah 100.318716 - 

0.823677 

4 Samaran 4 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.326349 - 

0.830332 

5 Samaran 5 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.316347 – 

0.832769 

6 Samaran 6 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.326037 – 

0.836315 

7 Samaran 7 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.324953 – 

0.824436 

8 Samaran 8 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.320054 – 

0.825964 

9 Samaran 9 Leher Angsa 1 Sedang 100.321468 – 



 

 

 

 

dengan tangki 

septik dan 

resapan 

0.831811 

10 Samaran 10 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.317505 – 

0.819096 

11 Samaran 11 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.328711 – 

0.832819 

12 Samaran 12 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.325806 – 

0.829154 

13 Samaran 13 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.32813 – 

0.828914 

14 Samaran 14 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.328455 – 

0.829409 

15 Samaran 15 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.32207 – 

0.814865 

16 Samaran 16 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.343937 – 

0.871859 

17 Samaran 17 Leher Angsa 

dengan tangki 

septik dan 

resapan 

4 Tinggi 100.348792 – 

0.882324 

18 Samaran 18 Leher Angsa 

dengan tangki 

septik dan 

resapan 

1 Sedang 100.342744 – 

0.870865 

19 Samaran 19 Leher Angsa 

dengan tangki 

0 Rendah 100.346205 – 

0.869071 



 

 

 

 

septik dan 

resapan 

20 Samaran 20 Leher Angsa 

dengan tangki 

septik dan 

resapan 

4 Sedang 100.3303028 – 

0.947725 

21 Samaran 21 Leher Angsa 

dengan tangki 

septik dan 

resapan 

4 Sedang 100.336147 – 

0.853861 

22 Samaran 22 Leher Angsa 

dengan tangki 

septik dan 

resapan 

3 Sedang 100.330302 – 

0.852275 

 

 

  



 

 

Lampiran G 

Dinas Penanaman Modal Dan Pelayanan Satu Pintu Kota Padang 

 

  

PEMERINTAH KOTA PADANG
DINAS PENANAMAN MODAL DAN

PELAYANAN TERPADU SATU PINTU
Jl. Jendral Sudirman No.1 Padang Telp/Fax (0751)890719

Email : dpmptsp.padang@gmail.com Website : www.dpmptsp.padang.go.id

REKOMENDASI
Nomor : 070.7500/DPMPTSP-PP/VII/2023

Kepala Dinas Penanaman Modal dan Pelayanan Terpadu Satu Pintu Kota Padang setelah membaca dan
mempelajari :

1 Dasar :
a. Peraturan Menteri Dalam Negeri Republik Indonesia Nomor 7 Tahun 2014 tentang Perubahan

atas Peraturan Menteri Dalam Negeri Republik Indonesia Nomor 64 Tahun 2011 tentang
Pedoman Penerbitan Rekomendasi Penelitian;

b. Peraturan  Walikota  Padang  Nomor  11  Tahun  2022  tentang  Pendelegasian  Wewenang
Penyelenggaraan Pelayanan Perizinan Berusaha Berbasis Risiko dan Non Perizinan Kepada
Kepala Dinas Modal dan Pelayanan Terpadu Satu Pintu;

c. Surat dari Poltekkes Kemenkes Padang Nomor : PP.03.01/0356/2023;

2. Surat Pernyataan Bertanggung Jawab penelitian yang bersangkutan tanggal 28 Juli 2023
Dengan ini memberikan persetujuan Penelitian / Survey / Pemetaan / PKL / PBL (Pengalaman Belajar
Lapangan) di wilayah Kota Padang sesuai dengan permohonan yang bersangkutan :

Nama : Ichlasul Arby Yade
Tempat/Tanggal Lahir : Padang / 07 Desember 1998
Pekerjaan/Jabatan : Mahasiswa
Alamat : Jl. Jamal Jamil No.17 RT 003 RW 001, Surau Gadang, Nanggalo, Padang

25146
Nomor Handphone : 081276418974
Maksud Penelitian : Skripsi
Lama Penelitian : 28 Juli 2023 s.d. 31 Agustus 2023
Judul Penelitian : Analisis Spasial Kejadian Diare di Wilayah Kerja Puskesmas Lubuk

Buaya Tahun 2023
Tempat Penelitian : Wilayah Kerja Puskesmas Lubuk Buaya Padang
Anggota : -

Dengan Ketentuan Sebagai berikut :

1. Berkewajiban menghormati  dan mentaati  Peraturan dan Tata  Tertib  di  Daerah setempat  /  Lokasi
Penelitian.

2. Pelaksanaan penelitian agar tidak disalahgunakan untuk tujuan yang dapat mengganggu kestabilan
keamanan dan ketertiban di daerah setempat/ lokasi Penelitian

3. Wajib melaksanakan protokol kesehatan Covid-19 selama beraktifitas di lokasi Penelitian
4. Melaporkan hasil  penelitian dan sejenisnya kepada Wali  Kota Padang melalui Kantor Kesbang dan

Politik Kota Padang
5. Bila  terjadi  penyimpangan dari  maksud/tujuan penelitian  ini,  maka Rekomendasi  ini  tidak berlaku

dengan sendirinya.

Padang, 28 Juli 2023

Tembusan :
1. Direktur Poltekkes Kemenkes Padang
2. Kepala Dinas Kesehatan Kota Padang
3. Kepala Kantor Kesbangpol Kota Padang

* Dokumen ini Telah ditandatangai secara elektronik menggukan sertifikat elektronik yang diterbitkan BSrE Sesuai UU ITE No. 11 Tahun 2008 Pasal 5
  Ayat 1 yang berbunyi "Informasi elektronik dan/atau Dokumen Elektronik merupakan alat bukti hukum yang sah."
* Unduh veryds BSRe di playstore untuk pembuktian keaslian dan legalitas dokumen ini.



 

 

 

 

UPTD Puskesmas Lubuk Buaya 

 


